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GETTING STARTED WITH ASTA EASYPLAN

Asta Easyplan: Simple planning tool for small projects

This booklet is designed to help you start using Asta Easyplan as quickly as 
possible. As you work through this booklet, you will build up a small sample 
project. The techniques you learn as you do this will help you to plan your own 
projects using Asta Easyplan.

This booklet introduces you to the basics of Asta Easyplan. To learn more about 
what you can do with Asta Easyplan, refer to the Asta Easyplan Help and tutorial, 
which are available on the Help tab of the Backstage view.

CREATING YOUR FIRST PROJECT

1. Start Asta Easyplan from the Windows® Start menu.

2. Click File, then click New. The New Project Wizard

appears.

3. Select Easyplan Tutorial Template in the

Template field.

4. Enter a name for the project in the Project name

field. The project’s filename defaults to the project

name that you have entered.

5. Click Next. The second screen of the wizard appears.

6. Specify the date on which you want the project to

start in the Start date field, then click Next. The

third screen of the wizard appears.

7. Select Days in the Snapping time unit field to

specify that you will be planning the project in a time

units of days, then click Next. The final screen of

the wizard appears.

8. Click Finish to close the wizard and create the

new project.

Asta Easyplan

THE ASTA EASYPLAN 
WINDOW

The Asta Easyplan window comprises 

the following main elements:

	Quick Access toolbar	

Tabs

Ribbon

Project view	

Date zone	

Spreadsheet

Bar chart	

Properties view	
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CREATING YOUR FIRST TASKS

1. Click the Wizards tab of the Ribbon to display a list of

the wizards available in Asta Easyplan.

2. In the New group, click New Tasks. The New Tasks

Wizard appears.

3. Click Add. A new row appears in the grid, representing

a new task.

4. Click in the Task Name column and enter Foundations.

5. Click in the Duration column and enter 3.

6. Follow the above three steps to create these four

more tasks:

7. Click Next. Ensure that the Use the Link Tasks

Wizard… check box is selected on the following screen,

then click Finish to close the wizard and create the

tasks in the bar chart.

LINKING TASKS

The Link Tasks Wizard appears automatically as the New 

Tasks Wizard closes. This wizard provides you with a 

simple way of creating links, which specify the order in 

which tasks take place:

1. Click Next when you have read the wizard’s

introductory screen.

2. The second screen of the wizard displays two panes,

each one listing the tasks in the project. Click the

Foundations task in the left pane and click the

Brickwork task in the right pane to indicate that you

want to create a link from one to the other.

3. With Finish-to-Start (FS) selected in the Select the type

of link… field and the Align tasks check box selected,

click Create.

A link is drawn between the two tasks and the start

of the Brickwork task is aligned with the finish of the

Foundations task.

4. Follow the above two steps to create two more Finish-

to-Start links: one from the Brickwork task to the

Roofing task and one from the Roofing task to the

Electrics task.

5. Click Finish when you have linked the tasks.

Task Name	 Duration

Brickwork	 10 days

Roofing	 3 days

Windows & Doors	 2 days

Electrics	 4 days
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You can also create links by drawing them directly in the 

bar chart. You will do this now by drawing a link from the 

start of the Roofing task to the start of the Windows & 

Doors task to indicate that they can start at the same time:

1. Position the mouse pointer at the bottom-left of the

Roofing task so that the cursor changes to .

2. Hold down the left mouse button and drag the cursor

away. Notice that a line now stretches from the task to

the cursor.

3. Position the end of the link at the bottom-left of the

Windows & Doors task, then release the mouse button.

A link is drawn

between the tasks,

which are aligned so

that they start on the

same date.

4. Now draw a link

from the finish of the

Windows & Doors

task to the start of

the Electrics task.

DRAWING TASKS IN THE BAR CHART

As well as using the New Tasks Wizard to create tasks, 

you can create them by drawing them directly in the bar 

chart. Here, you will insert a new blank bar into the project 

and draw a task on it:

1.	Move the mouse pointer over bar 3 in the Line column

of the spreadsheet, then click. Bar 3 – the bar

containing the Roofing task – is selected.

2.	Press INSERT. A blank bar is inserted above the

Roofing bar.

3.	Position the mouse pointer over the blank bar, hold

down the left mouse button, then drag the cursor to the

right. As you drag, a popup box displays the start date,

finish date and duration of the task you are drawing.

4.	Release the mouse button when the task is three days in

length.

5.	Click in the Name column of the spreadsheet in the new

bar and enter Plumbing.

EDITING THE DURATION OF TASKS

To edit the duration of a task in the spreadsheet:

1. Click in the Duration column in bar 2 of the

spreadsheet.

2. Change the duration of the Brickwork task to 8d

(8 days) and press ENTER.

To edit the duration of a task in the bar chart:

1. Position the mouse pointer over the finish of the

Foundations task so that the cursor changes to . 

2. Hold down the left mouse button, then drag to the

right.

3. Release the button when the task is 4d (4 days) long.

Durations in Asta Easyplan can be shown as ‘elapsed’ 

or ‘working’ time. Elapsed time includes working and 

non-working time (eg holidays, weekends and evenings); 

working time excludes non-working time. By default, 

durations are shown in working time.

DRAWING MID-LINK TASKS

Links do not have to start and finish at the start or finish 

of tasks; they can start at any point along a task. Here you 

will draw a link between the Brickwork and Plumbing tasks 

that indicates that the Plumbing task can start two days 

after the Brickwork task has begun:

1. Position the mouse pointer at the bottom of the

Brickwork task, two days to the right of the start of the

task, so that the cursor changes to .

2. Hold down the left mouse button and drag the cursor

away to the start of the Plumbing task. The two tasks

are linked and the Plumbing task is aligned so that it

starts two days into the Brickwork task.

3. Now draw a link from the finish of the Plumbing task to

the start of the Electrics task.
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ALIGNING TASKS ACCORDING TO LINKS

Notice that as you have changed the duration of two tasks 

in the project, the tasks are no longer aligned correctly 

according to their links.

To re-align the tasks according to their links, on the Home 

tab of the Ribbon, in the Schedule group, click Align 

Linked Tasks.

SAVING YOUR PROJECT

You may have noticed that the bars you have edited have 

been coloured blue. This colouring indicates that the 

work on the bars has not been saved. The blue colouring 

disappears when you save the project.

To save your project, click  in the Quick Access toolbar. 

It is good practice to save regularly.

COLOUR-CODING TASKS

You can colour-code the tasks in your projects so that 

their appearance represents something relevant to you. 

You use code libraries to do this. For example, you could 

use them to show the department or person responsible 

for each task, or the location of each task.

You create code libraries in Library Explorer, then assign 

them to tasks. In this example, you will use codes that  

are already set up.

ASSIGNING CODES TO TASKS

1. Click the + next to Code Libraries in the project view to

view the code libraries that are set up in the template.

2. Click the + next to

the Floor Level code

library to view the

codes it contains.

You can assign codes

to tasks by dragging

and dropping them

onto tasks from the

project view.

3. Drag the Ground code

and drop it onto the

Foundations task.

A dialog appears,

asking whether you

would like to display

codes from this

library in the bar

chart.

4. Click Yes. The task is

coloured according

to the code you have

assigned to it.

5. Drag and drop

appropriate codes onto the rest of the tasks. Their

appearance changes according to the codes you

assign to them.

WORKING WITH RESOURCES

You can use Asta Easyplan to plan the resources you will 

use in a project: permanent resources such as people and 

machinery, and consumable resources such as materials, 

components and utilities.

You can create your own resources in Library Explorer. In 

this example, you will work with resources that are already 

set up in the template.
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ASSIGNING RESOURCES TO TASKS

1. Click the + next to Permanent Resources in the project

view to view the permanent resources that are set up in

the template.

2. Drag the Plumbers resource and drop it onto the

Plumbing task.

3. Drag the Carpenters resource and drop it onto the

Windows & Doors task.

4. Drag and drop the Electricians resource onto the

Electrics task.

Allocation bars

appear below

the tasks,

indicating which

resources have

been assigned to

the tasks.

VIEWING AN ALLOCATION HISTOGRAM

You can use histograms to graph detailed cost and 

resource information, highlighting important details that 

are updated in real time:

1. On the View tab of the Ribbon, in the Graph group,

click New Histogram. A new pane appears below the

project view, spreadsheet and bar chart:

2. Click the Resource Selector field in the new pane and

select the check boxes to the left of the Carpenters,

Electricians and Plumbers resources.

3. Click the Report Selector field and select Allocation,

Availability and Over Allocation. A histogram appears,

showing the allocation of the selected resources.

GROUPING RELATED TASKS TOGETHER

You can group related tasks together using summary 

tasks. A summary task takes its position and duration 

from the position and duration of the tasks within its 

summary group.

1. On the Wizards tab of the Ribbon, in the Organise

group, click Organise Tasks. The introductory

screen of the Organise Tasks Wizard appears.

2. Click Next to view the second screen.

3. Select the check boxes next to all of the tasks in the

project except the Foundations task.

4. Enter Post-Groundwork in the Enter a name for the

summary task field and click Finish. The selected

tasks are grouped together by a summary task. Note

that the bar on which the summary task is located is

highlighted with a different background colour.

PROGRESSING A PROJECT

You progress projects to keep them up to date. One of the 

easiest ways of doing this is by using the Enter Progress 

Wizard:

1. On the Wizards tab of the Ribbon, in the Progress

group, click Enter Progress. The first screen of the

Enter Progress Wizard appears.

2. Click Next to view the second screen.

3. Select the check box next to the Foundations task to

indicate that you want to progress it, then click Next to

view the final screen.

4. Click in the Percent

Complete column and

enter 50, click outside the

field then click Finish. The

Foundations task is now

shown to be 50% complete.
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PRINTING A PROJECT

Asta Easyplan offers you a wide range of printing options, 

which are all accessible on the Print dialog.

To exclude items from a printout, format the bar chart and 

exclude the items from the current view before you print. 

For example, you may want to exclude links, progress or 

allocations, depending on who is to view the printout.

You can also use the controls in the Show/Hide group 

on the Format tab of the Ribbon to turn elements of the 

display on and off instantly:

To create a simple printout of the current view:

1. Click File, then click Print. The Print tab of the

Backstage view appears, displaying a preview of what

the output will look like.

GETTING HELP

Asta Easyplan’s online help provides you with all the 

information you need to use Asta Easyplan to the full. To 

access the help:

 l	 Press F1 to access help about the current dialog.

 l	 Click File, click Help, then click Help.

Use the Contents and Index tabs and the Search facility to 

locate the information you want.

2. Click Print Now. The output is sent to your default printer.
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